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DISCLAIMER OF WARRANTY

By using this software and documentation ("WML") you must accept 
this disclaimer of warranty:

WML is provided "as is" without any warranties or conditions, 
expressed or implied, including, but not limited to, those concerning 
merchantability and fitness for a particular purpose.  By using WML, you are 
expressly releasing the author, Angel Babudro, from any liability resulting 
from the use of this software and documentation.  You must assume the 
entire risk of using WML.  Please test and supervise WML thoroughly before 
relying on it.

COPYRIGHT

WML is owned and copyright (c) 1989-1993 by Angel Babudro, all 
rights reserved.  You may only use and/or distribute WML under the License 
terms below.

LICENSE

1. WML is being distributed as Shareware.  This program is not free.  
WML is licensed for individual personal use and evaluation for an unlimited 
time.  Use and evaluation by businesses, corporations, governments, 
consultants or professionals of any type, or individuals in any kind of 
organized or commercial activity is limited to 60 days, after which time the 
REGISTERED Edition of WML must be purchased or the use of Unregistered 
Edition of WML must be discontinued.

2. You may keep as many backup copies of WML as you wish, but you 
may not run a Registered Edition of WML simultaneously on more than one 
computer.  Additionally, you are granted the right to share WML with others, 
as long as you distribute the WML archive exactly as you received it, with all 
associated files included.  REGISTERED USERS may NOT distribute the 
separate file CONFIG.WDT nor the font files (*.SFP and *.SFL).

3. Under no circumstances may you charge any fee or receive any 
other form of consideration for distributing the WML files without express 
written consent from the copyright holder, Angel Babudro, other than to 
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charge a fee of not more than US$6 (six dollars) for the disk and/or service of
distribution.

TECHNICAL SUPPORT (HOW TO REACH ME)

The best way to figure out a problem is to keep hitting keys until it all 
works out...  :)  Just kidding.

If you have questions or need help, just drop a note to me or send 
mail to the BBSs listed below.  Registered Edition users, vendors, and sysops 
may contact me via telephone as well.  Sysops and shareware vendors 
please see VENDOR.DOC for distribution information.

Mail Angel Babudro, "Organic Computer Wizardry", 
28 Mulberry Street, Clinton, NY USA 13323-1506

Phone (315) 853-6942 9am - 5pm Eastern Time, Mon-Fri

BBS Angelo Babudro (to avoid gender confusion)
West Coast Researcher's BBS, So Cal (805) 949-8151 USR DS
East Coast Nite-Air, Central NY (315) 339-8831 USR 14.4

INTRODUCTION

Introducing What Mailing List? version 2.  In the summer of 1989 
WML was originally written using QuickSilver - a dBase compiler.  As features 
were added WML got bigger and slower until I realized it could never become
the product I had envisioned unless I switched languages.  During the 
summer of 1992 I re-wrote the whole darned thing in PDS/BASIC 7.

What Mailing List? provides a simple and flexible way to easily 
manage and print mailing lists.  My focus has been providing the tools to 
track relatively small amounts of information (500 to 2,000 names per list in 
up to 250 lists).  WML is ideally suited for those times when you want a good-
looking envelope or label, or maybe a hundred, but not fifty thousand.  
Software that is made to handle huge lists tends to be horribly complicated 
to use.  WML is different.

I use WML regularly: when I need an envelope I print it on my laser, 
and when I need labels I switch to the dot matrix printer.  It's very fast and 
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easy for me, and I hope you find WML just as easy and fast to use.

Learning WML can probably be done as you are using it, with little or 
no help from this manual.  Keep an eye on the bottom of the screen since 
that is where I put special function keys.  If you use a mouse, many of these 
commands can be accessed with the mouse as well.  Many of my clients' 
greatest fear is losing data, so I'd like you to know that I use WML almost 
every day and my information is safe, plus WML will always warn you before 
it erases or abandons information so you can't lose anything without knowing
about it first.  Guarantees are impossible to make (actually, they're easy to 
make but impossible to keep), but I can say that WML is as "safe" as any 
other high quality PC software product.  I've never lost a byte of information 
nor have I heard of anyone else who has.

This shareware manual is intended for people with some knowledge 
of computers, MS-DOS, and data bases.  A detailed manual is available to 
registered users which is more thorough, covering elementary and advanced 
topics not covered here.

Any trademarks I happen to mention here are, of course, property of 
their respective owners.

Thanks to The Researcher's BBS sysop Skip Taylor for all his beta 
testing and being a great friend.  Thanks to HDM IV author Jim Hass for his 
support, feedback, and his excellent hard disk menu.  Many thanks and good 
karma to sysops Dan Healy, Mike Halley, and Tom McElvy who have been 
very helpful in shaping the future of WML ── it makes my day every time one
of you calls.  :)

UPDATES, ORDERING METHODS, AND REGISTRATION FEES

I hope that you are so happy with WML that registering will be reward 
enough in itself, but I think it's more fun & exciting to get something new.  
And so you shall!  I do so much programming on this machine of mine that 
there are updates practically every day, so you will definitely get an updated 
version.  One day I realized that if I'm always updating my software some 
people will want to wait for that day when it's "done."  So I thought, "Hey, 
wouldn't it be nice if software publishers gave out free updates so you 
wouldn't have to wonder when the best time was to register?"  So I decided 
to do just that...
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Updates Are Free

Really.  Register yourself for WML version 2 and your registration is 
valid for ALL releases of WML version 2.  You can download updated versions
from a bulletin board or get a copy from a friend or shareware vendor and 
over-write the old files with the new ones.  The new version will recognize 
your registration "stamp" in your CONFIG.WDT file (which is NOT distributed 
with the Unregistered Edition).  If you can't find WML on a bulletin board in 
your area, tell a sysop you want it and give her/him my address and BBS 
contact numbers; maybe s/he can get it for you (I've heard of FREQing files; 
don't know what it is, though, so ask the sysop).

If I must provide a new registration file or if you want to get an update
through the mail, I will provide updates on disk for $7.00 (add shipping 
outside the U.S.).  Prices are subject to change, but basically I want to cover 
all my costs with a small buffer.  You may also send me a disk with return 
postage, a return label, and $2.00; I'll re-use the envelope and mail the 
update to you without charge.

How often is WML updated?  At this stage I am releasing a new 
version about every other month with a major update happening every six to
eight months.  There are a couple of major updates in the works (like bar 
codes on dot matrix labels), but most of the updating I've been doing lately 
is refining the documentation and fixing bugs with what's already there.  If 
you find a bug, please let me know about it (be as thorough and specific as 
you can, please) and I will fix it and send you an update.

I would like everyone to see my software as a bargain, so I want to 
keep my prices low.  I'm still new at this shareware business, though, so I 
hope you understand if I need to fine-tune things.  If this document is more 
than nine months old it would be a good idea to check with me before 
ordering.

How To Order

U.S. customers please send cash, check, or money order.  Canadian 
customers please send cash or Canadian International Money Order (CIMO).  
Customers in other countries please send U.S. funds drawn on a U.S. bank.  If
you send cash use a "security" no-see-through envelope and you may want 
to send it via Registered mail, too.
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If you prefer to use a credit card, you can order WML from Public 
(software) Library with your MC, Visa, AmEx, or Discover card by calling 800-
242-4PsL (from overseas: 713-524-6394) or by FAX to 713-524-6398 or by 
CompuServe to 71355,470.  THESE NUMBERS ARE FOR ORDERING ONLY.  I 
CANNOT be reached at those numbers.  To contact me for information about 
dealer pricing, volume discounts, site licensing, the status of shipment of the
product, the latest version number, or for technical information, call 315-852-
6942 or write me at 28 Mulberry Street, Clinton, NY USA 13323-1506.  
Shareware is "try before you buy" so please understand that product returns 
are not allowed.

Please note that PsL will add $3 for shipping & handling to U.S. as well
as Canadian orders.

Pricing

Registration with Disk — A single copy costs $29.  You will receive the 
latest Registered Edition of What Mailing List? with automated 
installation, the latest version of this documentation on disk, some 
PCL soft fonts that I have put together (including a postal bar code 
font), and notification of updates.  See below for printed & video 
manuals.

Multiple Copies / Wholesale ── If you would like to resell What Mailing 
List?, give it to clients as a promotional item, have multiple locations 
at which you would like to install WML, etc., you may receive a 
discount on the price of WML as follows:
- 2-4 disk copies on the same order 40%
- 5 or more disks on the same order 50%

Site License ── use WML on as many computers as necessary at a single 
location of a single business.  Purchase a single copy (see above) 
and add the appropriate site license fee below:

Up to 4 computers $30.00 per site
Up to 10 computers $70.00 per site
Up to 20 computers $150.00 per site
Any number of computers $400.00 per site

Manuals ── printed on my laser printer and bound in a flexible 3-ring binder,
these manuals contain pictures & detailed descriptions of each 
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screen, some basic computer & data base lingo, and an index.  I want 
people to have and use these manuals, but I am very concerned 
about deforestation.  Experienced users will probably have no need 
for a manual.
● One copy $8.00
● Multiple copies on same order $6.00 each

Video Manual — I am creating a video manual for WJS so you can learn by 
watching someone else do it.  The video manual will be available 
around June 1, 1993.  I can provide tapes in HiFi VHS, 8mm, or Beta 
formats.  I'm going to start by dubbing all the tapes myself and see 
how it goes; the prices below are good until January 1, 1994.  After 
this date please contact me before ordering a video manual.

All formats have a standard audio track so they can be played on any 
videotape machine, HiFi or not.

VHS HiFi, Beta HiFi, or 8mm PCM+HiFi $10.00

Complimentary Registered Editions

I would like to give away some complimentary registrations in return 
for a little bit of marketing assistance.

1. If you write a review of one of my packages and post it on a bulletin 
board, send me a copy of it showing the BBS's header and the name and 
phone number of the BBS.  Just give me your honest praise and criticism in a 
decent review.  Your review will be most helpful to me if it mentions your best
& worst-liked features and any ideas you have for improvement.  If you have 
any experience with other mailing list managers, please include your opinion 
of how they compare to each other.  This will help me decide the future of 
WML and for that help I will send you a complimentary registered disk.

2. It helps me to know which BBSs carry my software and the more the 
better, of course!  If you will upload a package to at least five public ("open")
BBSs, send me their names and phone numbers along with the archive name
you uploaded, and I'll send you a complimentary registered disk.  I would 
appreciate you uploading to time-share systems, private ("closed") BBSs, or 
part-time BBS, but please do not use these to apply for a complimentary 
registered edition.  BTW: I use an HST 14.4 modem so it would be best if you 
provided me with BBSs which also use HSTs so I can hook-up at high speed.
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3. If you are a consultant or other type of computer professional and your 
recommendation leads to one or more of your clients purchasing WML, just 
send me a note with your client's registration or have them mention your 
name when they register.  I will send a complimentary registered edition or 
an update for every registration you get for me.  This is in lieu of a multiple 
copy discount; I intend it for consultants who choose not to deal with sales 
tax.

I want your help with distribution, but please remember that this is not 
Microstuff Corp. — it's just me and my computer so please give me the help I
need in return for the freebie.  It helps a lot when you send back disks to be 
re-used - even the envelopes can often be re-used.  When you order a 
complimentary registration please fill in the appropriate information below 
PLUS the Invoice so I know what size disk you need, etc.

COMPLIMENTARY REGISTRATION APPLICATION

Please also fill in the Invoice on the following page (put $0 for the disk 
price and cross out the $2.00 for shipping).  For addresses outside the U.S. 
please add the extra shipping indicated - foreign shipping is a little too pricey
for me to give away.  If you want anything extra, like a printed manual, 
please include payment for these extra items.

(__) Review posted on (BBS name & number)________________________
Include a copy of the review, please.

(__) I uploaded (archive name, like WML21.ARJ)__________________
to these five 24-hour public ("open") BBSs:

BBS Name                             Phone Number/Modem Type      Sysop Name  

1_______________________ ________________________ _______________
2_______________________ ________________________ _______________
3_______________________ ________________________ _______________
4_______________________ ________________________ _______________
5_______________________ ________________________ _______________

These offers subject to withdrawal or change at any time without notice.  
All prices are subject to change without notice.  Bulletin Board Sysops please 
see the file SYSOP.DOC for special pricing and information; vendors & sysops 
please see VENDOR.DOC.

--



What Mailing List?

That said, I'll do my darndest to honour these offers forever.

Angel Babudro — "Organic Computer Wizardry"
28 Mulberry Street, Clinton, NY USA 13323-1506

(315) 853-6942 Mon-Fri 9-5 Eastern Time
(home phone, so remember east coast is 3 hours later than west)

Please register the Shareware you keep.
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INVOICE & REGISTRATION FORM
For Credit card orders see "How To Order" above

Your Name________________________________________________________

Company Name_____________________________________________________

Address__________________________________________________________

City_________________________ State/Prov_______ Zip code_________

Registration Reg & disk - $29 x Qty _____ $_______ 

Multiple/ 2-4 disks -- deduct 40%
Wholesale 5 or more -- deduct 50% (_______)

Site License Up to 4 CPUs add $30; Up to 10 add $75
(add to above) Up to 20 add $150; Unlimited add $400 _______ 

Printed Manuals One copy $8; 2 or more $6 each
Qty _____ x $______ each = _______ 

Video Manuals __VHS __8mm __Beta  $10 ea avail 6/1/93 _______ 

Shipping & Canada, AK, HI, VI, PR add $3 _______ 
Expenses Other countries add $9 per copy _______ 

** T O T A L ** _______ 

Disk size & quantity [__] 3½" [__] 5¼"
Drive density [__] Low (DD) required [__] High (HD) ok
Extended densities [__] FDFORMAT extended densities okay

Printer make(s) & model(s)______________________________________

Which version are you using now?________________________________

Where did you get it (BBS name)?________________________________

WML has been delivered to and accepted by customer.  Upon receipt of this 
paid invoice the latest Registered Edition disk and any options chosen above 
will be sent.  Send cash, cheque, money order in U.S. funds; Canadians send 
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Cdn$ or CIMO.  NYS residents add sales tax.  Mail this page with your cash, 
cheque or money order to Angel Babudro, 28 Mulberry Street, Clinton, NY 
USA 13323-1506.  Allow 1-3 weeks for the latest version to land on your 
doorstep.  Thank you for your order!
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SYSTEM REQUIREMENTS

The bare minimum you will need is:
1. Any IBM-PC-compatible with a 720k floppy or better
2. At least 370k of free RAM
3. MS/PC-DOS 3.3 or 5.0

I recommend you use:
1. An 80286 or faster computer
2. A hard disk with at least one megabyte of free space
3. At least 512k free RAM (use CHKDSK to check your RAM)

WML has been tested on MS-DOS 3.3 and 5.0 and with 4DOS.  It 
should work properly under PC-DOS or MS-DOS version 3.1 or later.  You will 
need 400-600k of disk space for WML and its files, depending on which 
optional files you decide to keep on your disk, plus space for the files you will
create.

WML will detect whether you have a monochrome or colour card 
installed, but it cannot detect what type of monitor you have.  If the screen is
difficult to read, try starting with the "/M" switch (for "M"onochrome) like so: 
"WML /M".

Storage Requirements (Disk Drives)

Although WML has a theoretical limit of 5.5 million names per mailing 
list file, you would need a supercomputer or a lot of time to manage it.  A 
386dx/20 handles 2,000 names or less well; a 386dx/40 can handle 3,000; a 
PC/XT gets bogged down at around 700 names or so.  I imagine that a 486dx 
can probably handle 4,000 to 7,000 names per list without much trouble.  
Remember, you can have hundreds of files; these are just practical limits for 
each of those files.  Duplicate Checking slows things down, so if you have a 
huge list or a very slow computer, you might want to turn Dup Checking off.

Printers

WML supports two printers concurrently ── a laser printer and a dot 
matrix printer on LPT1, LPT2, or LPT3.  The laser printer must be a PCL 1-5 
printer (compatible with H-P LaserJet I, II, or III).  The dot matrix printer 
should be Epson- or IBM-compatible (as most are).
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If your printer is not on the list check in your printer's manual for its 
compatibility.  Most dot matrix printers are compatible with Epson or IBM, so 
try these if you can't find a proper match.  I test everything on my NEC 
P5300, but that's no guarantee that it'll work for you.  If something works 
improperly please send me a note explaining your problem and I will fix it 
right away.

WML has been tested on Panasonic 4450 (H-P LaserJet I-compatible) 
and H-P LaserJet III laser printers.  If I read the ads correctly, WML should 
work with the LaserJet IV as well.  I'm sure there are some lasers which could 
be better supported, so let me know if you own one of them!  LaserJet III 
owners will be happy to know that they can use the PCL 5 scalable fonts.

Networks

With version 2.1 I have placed file "locks" to test WML on networks 
which use the DOS SHARE utility.  I know LANtastic uses SHARE, and I think 
the majority of networks do, too.  Prior to version 2.1 every file was opened 
with exclusive access, meaning that it could not be shared over a network.  
This would not allow the configuration, group, abbreviation, or zip code files 
to be shared which would need to happen on a network.

I don't have a network nor the resources to put one together, so 
please tell me your experiences.  My intent at this point is to allow WML to 
run on a network but only allow one station to open a particular file, and 
allow the configuration, abbreviation, group, and zip codes files to be shared 
by more than one station unless they are being updated.  I wonder what will 
happen if two stations try to update the configuration at the same time or 
even try to open the same mailing list file.  Will someone please try some 
things like this and tell me what happens?

A future plan (which will happen sooner if I get requests for it) is to 
use record locking (versus locking the whole file) so that more than one 
station can share a file as long as they work on different records within the 
file.  This will take a fair amount of programming time and coordination with 
someone who can test it for me, so I'm giving it a low priority until/unless 
that special "someone" comes forward...

FILES WHICH MAKE UP THE PACKAGE
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What Mailing List? is made up of the following files:

WML.EXE The executable file
WML.HLP The help file
WML.TXT The ASCII text file of this document [*]
WML.WP The WordPerfect file of this document (so you can 

format it for your printer) [*]
POSTAL.DAT Zip codes file
PRINTER.DAT Printer definition file
MAILCODE.SFL PCL landscape USPS postal bar code font
READ.ME A text file of late-breaking news. Read this first. [*]
ORDER.FRM Order form for all of my software
VENDOR.DOC Information file for BBS Sysops & Shareware 

distributors/disk vendors [*]
SYSOP.DOC Special deals for BBS sysops & co-sysops [*]

These are the files which are provided with the unregistered package. 
Additional files will be created in the same directory as you use WML.  Files 
marked with [*] are not needed to run WML so they may be erased if disk 
space is a premium (I would appreciate, however, if you would keep 
ORDER.FRM around until you decide whether or not to order).

The Registered Edition contains extra files which are for use by the 
registered owner only.  So if you share WML with friends and BBSs, please 
ERASE these files:

*.SFP Portrait soft fonts
*.SFL Landscape soft fonts
CONFIG.WDT Registration stamp & configuration info

RUNNING What Mailing List? FOR THE FIRST TIME

Quick Start

Type "WML" from the DOS prompt, press "P" to open the Preferences 
menu.  Go down the list and fill in each preference window as necessary.  
Then use File/New to create a file, and enjoy.

Before you can start entering addresses you will need to create at 
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least one mailing list file.  Do this by selecting the "New" option under "File" 
(described below).  Before you can print anything you will have to set your 
Preferences, at the very least defining your printer(s).

Here's a more detailed explanation:  Highlight "Preferences" and press
◂─┘Enter (or press the letter "P", or point & click with your mouse) ── you 
will see a list of choices.  Select each item by pressing the highlighted letter 
or by highlighting it using the arrow keys and pressing ◂─┘Enter.

After you are done setting your preferences, press ESC to close the 
Preferences menu then press "F" for the File menu.  If no files are on disk, the
only option available will be "New" and "Exit".  Press "N" and type a name for
your mailing list file.  In a couple of seconds the list will be created and you'll 
be ready to go.  That's all there is to it!

WML should be installed in its own directory.  This not only help keep 
things organized on your hard disk, but it also speeds up execution as there 
is not as large a directory to search.

To start What Mailing List?, go to the disk and directory which 
contains the programme (e.g., "C:" <Enter> "cd \WML" <Enter>) and type 
"WML".  In a second or two you will see the welcome screen and the menu 
will appear.  On unregistered copies some licensing information is displayed 
and a 9-second reading pause is enflicted upon the unregistered user...

Using a Monochrome Monitor with a Colour Card

If you have a monochrome (aka Black & White) monitor connected to 
a colour adapter card then WML will use colours which may not be very 
readable.  CGA adapters are the worst, VGA may look fine.  In any case, you 
can start WML in monochrome mode by using the "/M" switch like so:

WML /M

Add the "/M" to your WML.BAT file using a text editor.  An even better 
way is to use a menu, such as HDM.  There are a few screens which do not 
"listen" to the /M — it's a low priority, but I am working to fix this.  Please let 
me know if you have difficulty.

Using the Menus
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I have used what I understand to be an SAA-compliant (Standard 
Applications Architecture) menu system.  Most folks know it better as the 
Macintosh or Windows menu standard.  Basically, there is a horizontal menu 
of choices -- File, Data Entry, etc.  Under each of the horizontal choices is a 
menu of functions pertaining to that item -- it is a two-dimensional menu, in 
other words.  The last item of the left-most menu is always Exit, to end the 
programme or the sub-menu you are on.

There are two ways to select an item from the main menu:

1. Press the letter which is highlighted in the option description
2. Use the Up/Down/Right/Left arrows to highlight the option you 

want then press ◂─┘Enter (a.k.a. RETURN or CR).

Some menus do not have highlighted options.  On these menus you 
must use the arrow keys to highlight your choice then press ◂─┘Enter.

If you want to cancel an operation you selected, just press the Esc 
("Escape") key.

Status Line

At the top of your screen is WML's title followed by the WML file you 
have open (if any).  At the bottom of the screen is a bar which looks like this:

Total│Selected│Bad/Omit│Pack│Index│01-01-1980

From left to right the items are:
1. Total records in the open file
2. Total records selected for printing
3. Total records bad or excluded from mailings
4. The word |Pack| if there are entries to be erased
5. Selected indexing method (name, company, address, or zip).
6. To-day's date (so far as the computer knows).  If you have a filter

chosen, this will be replaced with "Filter" followed by:
* "Sel" for Selected records only,
* "Del" for Deleted records only, or
* "SelDel" for both.
If the filter message is bright the selection is  unchanged, 
otherwise changes have occured.  For example, suppose you 
have set the filter to "Selected Only" then cleared the selection 
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status of a record.  The filter message would change to dim since
the filter is no longer accurate.

MANAGING & PRINTING YOUR FILES

The "File" menu contains options to use and manage your files and to 
print entries from these files.  The choices under the File menu are:

● New - Create a new mailing list file
● Open - Open an existing mailing list file
● Close - Close the open file
● Delete - Erase a file from the disk
● Back-up - Make a back-up copy of data files
● Restore - Restore data files from a back-up copy
● Format Floppies - Format floppy disks (for back-up use)
● Index - Change the order in which entries are displayed and printed

or specify which entries you would like displayed (called 
"filtering")

● Pack - Remove entries which are flagged to be deleted
● Import - Bring data into the open file from another file format
● Export - Send data to a different file format
● Print/Select/Query - Menu of ways to print your list, choose which 

entries are to be printed or otherwise operated upon, and search 
the file

● Exit - End WML and return to DOS

Many of these options cannot be used at certain times (e.g., if you 
have an empty mailing list file the Select option is useless so WML won't let 
you use it).  When an option is not valid it will be "gray" with no highlighted 
letter.

Creating a New File

File/New let's you create new mailing list files.  Up to 250 files can be
managed by What Mailing List?.  When you press ◂─┘Enter while this option 
is highlighted you will be asked to enter a name for the new file.  The name 
you enter will be checked for proper syntax and you will be warned if the file 
name you entered already exists.  If everything is okay your new file will be 
created and opened for use.

Opening an Existing File
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Just like using a filing cabinet, you have to open a file before you can 
see what's in it.  File/Open let's you open a file which has been previously 
created.

After you select this option you will be presented with a list of the 
WML files in the current directory.  Use the up and down arrow keys to 
highlight the file you wish to use, then press ◂─┘Enter.

Note that entries will be displayed and printed in the order indicated 
on the bottom status line.  To change the sort order use the Index menu.

Saving/CLosing a File

WML saves your information every time you change something.  If 
you enter information and press the Esc key or click on a "Cancel" button 
with your mouse a message will warn you about losing any changes you 
have made.  The only danger comes with a power outage or anything else 
that causes WML to end improperly (e.g., the reset button or Ctrl-Alt-Del are 
used).  However, even in this case the only thing you would have to do is re-
index the file ── no information would be lost.

Just the same, it's always safest to Close a file when you will be away 
from your computer for a while.  That way if anything happens while you are 
away your information is saved.  The other use for Close is when you want to
delete the open file.  The Delete function (below) will not let you delete an 
open file, so you must close it first.

Deleting a File

WML contains all the tools you need to manage your mailing list files. 
The File/Delete function gives you a convenient way to remove files from 
your disk.  When you select this option you will get the same file list you see 
with the "Open" option.1  Highlight a file and press ◂─┘Enter, and the 
computer will read the name back to you (to be sure you picked the right 
one) and ask for permission to continue.  If you press ◂─┘Enter (or click on 
"Ok") then the file will be erased from the disk (along with it's indices) and 
will no longer appear on lists.

1The list will not contain the name of the open file (if any), only 
the files which are "put away."
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Making Back-up Copies of Your Files

File/Back-up protects your information by allowing you to copy it to 
another disk.  Using Preferences/Back-up you should have decided how you 
wanted to perform a back-up -- using the DOS COPY command, ARJ, LHARC, 
or PKZIP (the default is DOS COPY).  After you select File/Back-up you will see
a summary window and the system will pause for you to enter the back-up 
destination (which is typically a floppy disk drive, but you may decide to 
back-up to another hard disk, a network drive, etc.).  All WML data files will 
then be backed-up to the destination disk and directory using the method 
shown in the window.

Please see also the section on choosing a back-up method under 
Preferences.

Restoring Files from a Back-up Copy

If you ever need to recover data files from a floppy disk you made 
using the Back-up command (above), just place the floppy disk in its drive, if 
applicable, and select File/Restore.  The method used to restore the files will 
be the one specified on the Preferences/Back-up window.  The system will 
pause for you to enter the source drive -- the one you used when backing-up,
which is typically a floppy disk drive, but may be another hard disk, a 
network drive, etc.  All WML data files will then be restored from the back-up 
copy to the WML directory.

Please see also the section of choosing a back-up method under 
Preferences.

Formatting Floppy Disks

This option is for those times when you have decided to make a back-
up copy of your data but don't have a formatted disk handy or want to re-
format a disk to check for any bad spots.  File/Format Floppies lets you 
format a floppy disk to your computer's standard density without exiting 
WML.  By "standard density" I mean that if you have a high density drive you
can only format high density disks (in other words, WML doesn't pass any 
parameters to DOS FORMAT).  There is an exception to this:

If you have What Floppy Format? (WFF.EXE) available somewhere in 
your DOS search path, WML will automatically access it for formatting floppy 
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disks so you can format any kind of disk using FDFORMAT.  (You will receive a
complimentary copy of the latest version of WFF with your WML registration. 
FDFORMAT is a Freeware product by another author and can be found on my 
support BBSs.)

Fixing Damaged Index Files (Re-Indexing)

Sometimes a data base's index files can be damaged.  This can 
typically happen with a power outage, Ctrl-Alt-Del while in WML, etc.  
File/Re-Index allows you to re-build the indices for a mailing list.  Just open 
a file then select this option; everything is automatic.

Removing Records Which Are Marked for Deletion 
(Packing)

File/Pack is used to remove deleted records from the mailing list data 
base which is currently in use.  When an item is marked for deletion from a 
mailing list file the records are not removed from the data base until this 
option is chosen.  This can be handy if you accidentally mark a record for 
deletion because you can "un-mark" it; or you could use this feature to mark 
all the records you want to delete then review the records on the screen 
before actually packing the file.

Importing Data from Other Software

File/Import allows you to read data from other files to become a part 
of the mailing list file you are using.  Once you select import, you will be 
shown a menu of file types:

- ASCII
- What Mailing List? 1.3 file
- What Mailing List? 2.x file
- Another dBase file

Highlight the type of file you would like to import and press ◂─┘Enter.

Importing ASCII Files

An ASCII file must have commas delimiting each field and one 
record per line (i.e., CR/LF or ASCII 13 10 terminates a record).  A 
completely definable ASCII import (just like the DBF import) will be 
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released soon.  For now, WML will import ASCII files generated by 
itself or CP/M NAD files (both of which are practically identical).  The 
structure of an ASCII record must be:

- First name (up to 30 characters when combined with the 
surname)

- Surname (last name) (up to 30 characters when combined 
with the first name)

- Company name (up to 35 characters)
- Address line 1 (up to 35 characters)
- Address line 2 (up to 35 characters)
- City (up to 21 characters)
- State abbreviation/Province (two upper-case letters in 

American mode or up to 15 characters in Canadian or International mode)
- Zip code (up to 9 numbers (no dash) in American mode or up 

to 10 characters in Canadian or International mode)

NOTE: Version 2.0 is only able to import these first 8 fields.  
Anything beyond the zip code on a line will be ignored.

Importing WML 1.x Files

If you have been using version 1 of WML (or earlier versions 
called "List Manager") you can import these files into WML 2.  List 
Manager files need to be imported into a WML file since there were 
structure changes between these versions.  So use your old WML to 
create new files & import any of those List Manager files, then bring 
up WML 2 and select this option.

After you select File/Import/WML 1.x you will see a list of DBF 
files in the current directory.  I have not yet figured out a good way to 
allow disk drives to be navigated in this window, so you are limited to 
the current directory.

After you select a file to import you will see a graph showing 
progress and the number of records imported will be shown on the 
status line.

Importing WML 2.x Files

This option is handy for consolidating several files into one.  Just 
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select File/Import/WML 2.x and you will see the file list box.  
Choose a file, then choose whether to import all of the records or just 
those which are selected for printing, and away it goes.  As usual, you
will see a progress graph and the record number count on the bottom 
status line will be updated.

This is a handy way to separate a group of entries which have 
grown too large.  For example, let's say you had a list of clients 
grouped by occupation and one occupation became so large that you 
wanted to put them in a separate file.  You could select all of the 
records with that particular group for printing.  Then, create a new file
and import the selected records.  Back in your old file you can delete 
all of the selected records.  Now you have a new file with just the 
records you want in it.

Importing Other dBase Files

Release 2.0y is the first to have a functional dBase DBF file 
import.  I'm happy to introduce it to you now.

WML's DBF import can handle any file made by dBase, FoxBase, 
dB XL, dB Fast, QuickSilver, Clipper, or any other dBase clone.  Many 
information organizers (including other mailing list managers) use the
DBF file format.  Chances are, if the file ends in DBF you can import it 
into WML.

When you select this option from the menus you will be asked to 
enter a file specification and "*.DBF" will be the default answer.  Type 
the name of the DBF file you want to import or use the DOS wildcards 
to scan a file list.  For example, you might type "C:\DBASE\*.DBF" to 
see a list of files in that directory or you might type the whole file 
name something like, "C:\DBASE\MYFILE.DBF".

Once the DBF file is established you will see two windows with 
field names.  On the right are the WML field names.  On the left are 
some or all of the DBF field names for the file to be imported.

Use the arrow keys to highlight a WML field in the right-hand 
window then press ENTER to define it and you will see a pop-up menu
of DBF field choices.  Highlight the DBF field and press ENTER.  You 
will see the field you chose highlighted in the left window as you 

--



What Mailing List?

move between the WML fields.  Press the F10 key to begin importing 
records from the DBF file.

If the dBase file you are importing does not have a field 
corresponding to one of WML's you do not need to define it.  A near-
future update to this function will be the ability to map more than one
DBF field to one WML field.

Export

Export is the reverse of Import:  It allows you to send information to 
these file formats:

- ASCII
- WordPerfect merge
- Microsoft Word merge
- Ventura Publisher

Most commonly information is exported to an ASCII file and then 
imported into a word processor, spreadsheet, or other programme.

WordPerfect Merge

When you select this option you will be asked for a file name.  
Enter the full file name you wish to use, including drive and path if 
necessary.  Once you finish with this function you will have an ASCII 
file which contains WordPerfect's merge codes.  To prepare the file for 
use, start WordPerfect, import the ASCII file (Ctrl-F5, 1, 2) then save it 
in WordPerfect format. 

Microsoft Word Merge

Just like with the WordPerfect Merge file, this option will make 
you an ASCII file which is in Word's merge format.  I don't use Word 
regularly, but I believe there is no special preparation needed to use 
the resulting file.  The most you might need to do is import the file 
and save it.

Ventura Publisher

This is a special form of an ASCII text file.  The resulting file will 
be given a "TXT" extension and each line of the data will begin with 
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an "at" sign (@), the name of the field, a space, an equal sign (=), 
another space, and then the data.  For example:

@NAME = ABC Company
@ADDRESS_1 = 123 Main Street

The file will be double-spaced since this is how VP determines 
end-of-paragraph in an ASCII file.

PRINT/SELECT/QUERY

Selecting this option under the File menu brings forth a whole new 
pull-down menu which lets you select or clear the records you wish to print 
and print labels/envelopes/etc.  After you choose it, a new menu will appear 
with the options:  File, All, Group, Date, City, State, Zip, Individual, and 
Actions.

Under the File submenu are options to print and exit the 
Print/Select/Query menu (back to the top menu).  Before printing labels, 
envelopes, or a phone book, you must first select the records to be printed, 
so I'll go through the select/query options first then the printing options later.

Selecting entries to be printed

Notice that the second item on the status line at the bottom of 
your screen shows the number of entries which are selected to print.  
This number will change as you use the options on this submenu.

"All" lets you mark or un-mark all records in the data base.  
"Group" lets you select or clear records according to the groups to 
which they belong.  "Date/New" will mark or un-mark records which 
have never been printed (i.e., the number of last mail date = 0); 
"Date/by Date" will select or clear records based on a specific date 
you provide.  "Individual/All" will allow you to scan the entire data 
base, marking and un-marking records one at a time; 
"Individual/Selected" will allow you to scan only those records which 
are currently selected.  City/State/Zip options let you select or clear 
options based on exact matches in these fields.

Query: Acting upon selected entries
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The "Action" submenu lets you perform actions on the selected 
records.  This is somewhat of a "query" function, if you like data base 
terminology.  Once you have selected records you can reset the group
settings for the records, flag them as deleted, or clear the delete flag. 
Please note that if you use the Group function it will replace existing 
group definitions with the new definition you specify.

Selection Examples

WML's Select feature may seem limited at first glance, but it is 
actually very comprehensive.  At the time of this writing I found 
myself thinking that WML couldn't do a certain type of query and then
realizing that it could, so I think some examples are in order.

Let's say you have two groups defined in a mailing list: Team A 
and Team B.  Of the entries on file, some are part of Team A, some 
Team B, and some are both.

Now, let's say you want to send a mailing to all Team A 
members.  First you may want to choose All/Clear to clear any 
existing selection, then you would choose Groups/Select and flag the 
group Team A in the Groups Window.

For another mailing you want to include all members of Team B 
who are not members of Team A.  First, clear any existing selection.  
Second, use Groups/Select to flag all members of Team B.  Finally, use
Groups/Clear to clear all members of Team A from the selection.

For another mailing you may want to include all members of 
Team A who have not yet received a mailing.  Use the Date/New 
option to select these.  Or you can use Date/by Date to select 
members who last received a mailing on a certain date.

Whatever you need to do, chances are WML will do it.  If you 
can't figure out how to get what you want, please let me know!

Printing

This is one of the most useful parts of WML since it puts your 
work on paper.  Under the Print/Select/Query submenu "File" you will 
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see options to print a list of group definitions, a phone book, laser 
envelopes & labels, and continuous envelopes & labels.  Some or all 
of the printing options may be "grayed-out" and unavailable for use 
depending on certain conditions.  For example, if you have not 
selected any entries for printing then all of the options except for 
"Group List" and "Exit" will be gray and you will not be able to select 
them.

Note:  The number of records which are selected for printing appears 
on the status line at the bottom of the screen.

Here is an overview of the sequence of events for printing:

Print Menu
│

Group List Phone Book Envelopes Labels Zip Dist
│ │ │ │ │

------------------W h i c h   P r i n t e r ?----------------
│ │ │ │ │

Print Print Select Define/ Print
return pick

address labels
│ │

Print Print
│ │
└ Update Times Mailed and

Last Mail Date

Group List

The Group List option lets you print a list of the groups you 
have defined.  If you have two printers defined you will be asked to 
choose the one to use.

Group List only appears if you have defined groups, and does 
not update the times mailed or last mail date.

Envelopes

The Envelopes option lets you print envelopes (what a surprise, 
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eh!?).

If you defined two printers on the Preferences/Printers screen you
will first be asked on which printer you want to print the envelopes.

Next, you will be given a menu of return addresses to print on 
the envelopes.  Select "None" if you do not want any return address 
to be printed or use the arrow keys to highlight the one you want and 
press ◂─┘Enter to select it.

When printing envelopes on a laser printer, any soft fonts you 
defined (on the Preferences/Printers screen) will be downloaded for 
printing then the postal bar code font will be downloaded, if present.  
Finally, the envelopes will be printed.

Note: If you are using an impact printer and have set the "Pause"
field to "yes" then you will be prompted to load each envelope and 
press ◂─┘Enter before the data is sent to the printer.  All dot matrix 
printers, with a few rare exceptions, have a sensor switch which 
detects when the paper has run out.  Some dot matrix printers, 
especially older models, stop printing when the paper moves past the 
sensor, rather than printing to the bottom of the form.  With 
envelopes this is a problem since the form is very short (typically 
about 4.5-inches long) and you want to print the return address about
2-inches from the bottom.

If your printer has this problem with single-fed envelopes, one 
trick you can try is to put a business card or other piece of paper 
against the sensor so it will print to the bottom of the envelope.  This 
defeats the paper-out sensor, though, so it's up to you to make sure 
everything is okay.

After all envelope data has been sent to your printer WML will 
ask if you want to update the Times Mailed and Last Mail Date for the 
records printed. Answer by pressing the ◂─┘Enter key for "Yes" or the 
Esc key for "No." Answering "Yes" will change the Last Mail Date of the
selected entries to today's date and the Number of Times Mailed field 
will be incremented by one.

A laser printer tip -- if the print density is uneven try changing 
the left or top offsets (on the Preferences/Define Envelopes screen) so
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all of the return address is on a constant thickness of paper.  Laser 
printers have trouble printing on uneven surfaces.  You might also try 
using a different brand of envelope.  As far as national brands go I 
have found that Meade recycled paper "security" envelopes work very
well, but the Stuart Hall ones do not (too thick).

During envelope printing you can press Esc to cancel printing.

If the soft font MAILCODE.SFL is in your WML directory then 
postal bar codes will automatically be printed on laser envelopes 
which have U.S. zip codes.  Bar codes on dot matrix envelopes & 
labels is coming soon.

Labels

Select this to print sheets of labels on your laser printer or 
continuous labels on your impact printer.

If you defined two printers on the Preferences/Printers screen you
will first be asked on which printer you want to print the labels.

● For laser labels, you will be asked for the specifications of your 
label sheet -- the number of labels across and inches (vertically) 
between labels.

● For impact printer labels, you will be given the menu of label 
types from which to choose the one you are using.

Note: During label printing you can press Esc to cancel printing.

You can change the left offset for impact printers on the 
Preferences/Label Types screen.  Some impact printers, such as the 
NEC P5300, have the paper sensor a few inches from the left margin.  
If you use a narrow strip of labels, such as the common 3.5 x 15/16 
labels, the printer will not "see" the labels and will, therefore, not 
print.

This is where the left offset comes in handy.  You can set a left 
offset of, say, 1.5 inches, then load your labels 1.5-inches from the 
left margin.

--



What Mailing List?

Got something for everybody in here...  :)

Phone Book

Since WML can track phone numbers, it would be nice if it could 
print them, wouldn't it?  Sure!  A nice 2-column phone book, suitable 
for folding into one's pocket.

You can print the phone book on your dot matrix or laser printer.  
A 12cpi to 17cpi mono-spaced (fixed) font will work best for the phone
book, although the entries themselves work quite well with 
proportional fonts.  If you use a proportional font for the titles you will 
find that the index at the top right of the page "floats."  Short of 
figuring out how to do width tables, this was the best I could come up 
with.  So just use Courier 12 or something like that.  Experiment to 
find the best method to print the phone book on your equipment.

The phone book will only include records which have been 
selected for printing, and does not ask to update the Times Mailed 
and Last Mail Date.  Entries without a phone number will just show 
the name & address (no trailing dots after the name).

Zip/Postal Code Distribution List

Here is a useful report for people who do bulk mailings.  It shows 
each of the zip codes included in the open file's Selected records 
along with a count of the total number of entries in that zip/postal 
code.  U.S. zip codes are classified by the 5-digit zip even if the entry 
has a 9-digit zip.  When you print your bulk mailing, just bring this 
report with you to the Post Office.  It is my understanding that they 
will use the report rather than count each envelope bundle by hand.

The Zip/Postal Code Distribution does not update the times 
mailed or last mail date since it does not print any entries.

DATA ENTRY

This menu of What Mailing List? lets you enter data into a mailing list 
or define groups and abbreviations.  "Names" accesses the mailing list entry 
screen.  "Groups" accesses the group definition window.  "Abbreviations" 
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accesses the abbreviations definition window.

Names

This is the main data entry screen of WML since it is where you enter 
and change your mailing list information.  You can only use this function 
when you have a mailing list file opened for use.  When you choose Names a 
window will open which has room for all of the information for a single entry.  
If the open file has any entries the window will be filled with the first entry on
file.  If the file is empty, a blank form will be displayed.

As you move through a mailing list file, a file position indicator on the 
right side of the screen will change to show you the displayed record's 
position in the file.  When you are entering a new record the indicator turns 
yellow (or bright white on a monochrome monitor) and is positioned at the 
bottom.

Special Keys and Key Combinations

While on the Names screen there are several special keys (such 
as PgDn) and key combinations (such as ^PgDn) shown at the 
bottom of the screen.

PgDn Move forward (down) through the file.  If you press PgDn on
the last record on file, What Mailing List? will beep.

PgUp Move backward (up) through the file.  If you press PgUp on 
the first record on file, What Mailing List? will beep.

^PgDn "Control-PageDown" — hold down the key marked Ctrl and 
press the PgDn key.  This tells WML to begin adding new records.

^Home "Control-Home" — moves to the first entry on file.  Hold 
down the Ctrl key then press the Home key.

^End "Control-End" — moves to the last entry on file.  Hold down 
the Ctrl key then press the End key.

Function Keys (F-Keys)

On the bottom of the screen you will see several function keys 
defined.  Function keys are labelled "F1" through "F10" along the left 
side of your keyboard, or "F1" through "F12" along the top of your 
keyboard.
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Using Filters

If you have selected one or more filters from the Index menu the 
entries you see will be only those included in the filter at the time the 
filter was set.  The Names screen will begin with the first entry with 
the filter criteria (e.g., the first deleted record on file may actually be 
the fifth record).

When records within a filtered set of records change, those 
records remain within the filtered set of records.  To illustrate, if you 
have the filter set to show you only those records which are selected 
for printing, then you go to the Names screen and change the Select 
flag for a record.  Since this record is no longer selected for printing it 
doesn't "belong" in the filtered set of records any more, but WML 
leaves it there so you can review the changes you have made to the 
records which were originally filtered.

To reset a filter (e.g., using the above example, to eliminate the 
records which were changed from the filtered set), just toggle the 
filter setting OFF then back ON again.

As you use the PgUp and PgDn keys the display will jump to the 
next or previous entry with the filter criteria.  The F2 (Find) key will 
display only those selections included in the filter.

Note: I decided that filters are more useful if they do not change 
dynamically.  That is, if you have the filter set to Selected records 
then you Clear (or un-select) a record, that record will still be in the 
filtered list until you reset the index or filter options.  Think of it this 
way: if you are reviewing a bunch of records you had marked for 
printing to make a final decision, it would be really a pain if, every 
time you changed a Select status flag, entries disappeared from your 
review list so you couldn't see which ones you had Cleared from being
printed.

If you want to reset the filtered list after changing many records,
just go to the Index menu and turn the filter off and back on.

Getting Help (F1/Help)

When you see the "F1/Help" message at the bottom left of your 
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screen if means there is context-sensitive help available for the field 
on which the cursor is sitting.  Whether or not the message is 
displayed you can press the "F1" key for help.  If there is no specific 
help for the item you are on you will get the Help Index.

In the State/Province field pressing F1 brings up a list of U.S. 
State and Canadian Province names from which you may browse and 
select one.  The abbreviation for the selected State or Province will be
placed in the record.

Locating Another Entry (F2/Find)

Use this function key to navigate through your mailing list.  
F2/Find opens a window showing all of the entries on file, one line per 
entry.  You can browse through the list to jump directly to the entry 
you want.

You will notice new function keys at the bottom of the screen 
while the Find function is active.  You can press a letter or number to 
go directly to the index-key entry beginning with that letter or number
(if you are using the Zip index press a "9" to jump to the first entry 
with a "9" zip code; if you are using the Company Name index you 
could press "K" to jump to the first company beginning with "K")2.  Use
the arrow and PgUp/PgDn/Home/End keys to move around the list.  
Press ◂─┘Enter to use the entry which is highlighted.

Grouping Entries Together (F3/Group)

This function opens a window showing all of the groups defined 
with arrows next to ones to which this record belongs.  You define 
groups by using the Data Entry/Groups screen (defined below).  
Basically, just highlight a group and press ◂─┘Enter; the arrow will 
appear and disappear (toggle) next to it ── an arrow means that the 
entry belongs to this group.

When you press the F3/Group key a window appears showing the
2The index is determined by the setting of the Index menu.  If the
index is set to Address, then the entries will be sorted by 
whatever is in the first address line ── starting with blanks, then 
numbers, then letters.  The current index is displayed on the 
status line at the bottom of the screen.
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groups defined.  Inside the window all of the group descriptions for 
this mailing list file are displayed (up to 255 groups).  You can move 
through the list using the up/down arrow keys, the PgUp/PgDn keys, 
or by pressing the first letter of the group description you wish to find.
When a group is highlighted, press ◂─┘Enter to select it or clear the 
selection.  Selected groups have an arrow to the left of them.  When a
group is Selected for an entry, it means that this person or business is
a part of that group.  For example, if you have a group called 
"Christmas List" you can Select this group for all people you want to 
be on your Christmas list.

Adding New Records

When you first use the Names screen on a new (empty) file, WML
will automatically place you in Add mode.  Once the file has 
information, however, you are initially placed in Edit mode (i.e., 
existing information is displayed for you to view and/or change).

To add a new record to the file just press ^PgDn (hold down the 
Ctrl key then press the PgDn key).  This places you in Add mode.  
You will see a blank data entry form and the file position indicator will 
go to the bottom and turn yellow (or bright white on a monochrome 
monitor).

While adding new records What Mailing List? checks for duplicate
names and addresses.  If you have duplicate checking enabled (on 
the Preferences menu) you will see an information window telling you 
about any duplicates and asking permission to continue.  An entry 
must contain something unique in personal and company name.  You 
can't enter two records with the same personal names and company 
name.  The only time I can think that you might need to enter a 
duplicate is if the same person & company has two offices.  I may 
figure out a way around this soon...

When you are finished entering new addresses you can change 
modes in one of three ways:

1. Press ESC on a blank form to return to the menu (if you press 
ESC and have changed any information on the screen you will be given a 
message and an opportunity to save it -- don't worry)

2. Press PgUp to move "up" to the existing records in the file (i.e., 
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switch to "change" mode)
3. Press F2 (Find) to locate an existing record

To abandon new information (i.e., if you have started entering 
something on the screen and decide you don't want to save it), press 
the Esc key before you finish the screen.

Changing Existing Records

While an existing record is displayed you can change 
information, mark it for deletion, exclude it from being printed, or 
mark it as being a bad address.

You can use your mouse to go to the field you want to change or 
use the arrow keys to move around.  After you have made changes 
just press F7 (Save), or press Esc (Cancel) to abandon any changes 
you made.

Using the Delete/Omit/Bad Address Flags

On the right side of the Names data entry window you will notice 
four lines which have square brackets [ ] to the left of them.  These 
are called flags (since they flag a condition) or toggles (since they 
act like toggle switches, being turned on and off).  If there is a check-
mark (√) inside the brackets then this item is selected, otherwise it is 
not.  For example, if a check-mark is next to the "Delete" flag then 
this record is marked for deletion and will be removed from the file 
the next time it is Packed.

You can set the toggles either with a mouse or the keyboard.  To 
use a mouse just place the mouse cursor anywhere on the item you 
want to change and press the left button.  The check-mark will turn on
and off as you click on the option.  To use the keyboard just press the 
Alt key (Menu); this will bring up a menu of the toggles.  Just highlight 
the one you want to change and press ◂─┘Enter.  Press Esc to cancel 
the menu.

The Delete toggle indicates whether a record is to be removed 
from the file the next time the File/Pack option is used.  The Bad 
Address toggle indicates that the entry is a bad address and should 
not be printed.  Likewise, Exclude indicates an entry which should 
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not be included in print-outs.  Records marked Bad or Exclude cannot 
be selected for printing.  The Select flag indicates whether the entry 
is selected for printing.  Only those entries which are selected for 
printing will print.

Using Smart Zip

Release 2.0g of WML brings Smart Zip -- a feature which can 
save a lot of typing if your mailings tend to target a region.  Using 
Smart Zip is easy -- it's automatic, there's nothing to do.  Every time 
you type in a zip/postal code, WML will look for it.  The state/province 
will always be filled in for you, although it is not always 100% 
accurate since some states overlap (according to the information I 
have).  If the exact zip code is on file (5 digits checked for U.S. zips) 
the city will also be filled in.  Otherwise, the city and state/province 
you enter will be remembered and the next time you type that zip 
code the city & state/province will be filled in automatically.

Macros & Key Words

Some mailing list packages use function key (F-key) macros to 
save you typing and let you define "key words" for entries.  What 
Mailing List? does all this, too, but in a slightly different way.

The use of macros can be simulated using WML's Abbreviations 
(described below).  A simple 1-5 letter abbreviation can expand to 
whatever you need.  For example, you can define an abbreviation 
"POB" which expands to the full text, "P.O. Box" or even "Post Office 
Box."

Note: Abbreviations are used on the address, comments, and city 
fields (although the city is usually automatically filled in via Smart 
Zip).

"Key words" are usually one or more short fields in which you can
put short key words (like "PRO" for "Prospects", "XMAS" for "Christmas
List", etc.).  WML gives you two flexible ways of accomplishing this 
same goal without cluttering the screen with extra fields:

1. Define group names into which your entries fit (such as 
"Service companies," "Christmas list," etc.).  While entering a new 
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name or viewing an existing entry just press the F3 key to pop-up the 
Groups window.  An entry can belong to none or as many as 20 
groups.  When you want to print your Christmas list just use 
Select/Query (under the "File" menu, described above):  Under the 
"Groups" menu choose the "Select" option.  You will see the familiar 
pop-up window showing all group definitions.  Select as many groups 
as you want then press F7.  All entries in those group(s) are now 
selected to print.

2. Place key words or phrases in the comment lines.  Let's say 
you had a customer list and in the comment lines you liked to keep 
track of which computer equipment your client's owned.  You might 
put things like XT, AT, 386, Laser, Tape, VGA, DTP, etc. in your 
comments.  When you want to mail a notice to all of your desktop 
publishing clients ("DTP" people), just use Select/Query (under the 
"File" menu, described above):  Under the "Phrase" menu choose the 
"Select by phrase in comment" option; enter the key "DTP" and press 
◂─┘Enter.  All entries with "DTP" somewhere in the comments are 
now selected to print.

Groups

Use this screen to define and change up to 255 group descriptions.  
Grouping entries together makes it easy to select just the people you want 
for mailings.  For example, if you are setting up a mailing list for your 
business which will contain retail stores and service companies you might 
want to make groups for each type of business.  You might also want to set 
up groups to identify the people who have responded to a mailing and those 
who have not.

Note:  Groups are an optional part of each record.  An entry may 
belong to no groups at all, or it may belong to a maximum of 20 groups.

Use the Up and Down Arrows to highlight existing entries and press 
◂─┘Enter to edit.  Press the Ins (Insert) key to insert a new entry.  Press the 
Del (Delete) key to delete (erase) an entry.

Note:  When you tag a mailing list entry as belonging to a particular 
group, WML remembers the record number of the group, not the actual 
name.  So if you change the name of a group all entries will reflect the 
change.  If you delete a group, any entries which were part of that group will 
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remember the record number; next time this record gets used for a new 
group these entries will "belong" to the new group.  The reason for this is 
that it could be a very slow process to have WML search through every 
mailing list file to remove a group codes from all files -- if you had many large
mailing lists it could take minutes or hours to delete a group code.  I didn't 
think that was a good way to do things...

Abbreviations (Macros)

This is a handy feature of WML ── it lets you define abbreviations to 
be used in entering your data.  This is the same concept as a macro.  
Abbreviations will be used on the address, city, and comment lines of entries.

Use Ins/Del to insert and delete abbreviations, or use the Up/Down 
arrows to highlight and change existing abbreviations.

An abbreviation entry consists of an abbreviation and the full text for 
the abbreviation.  For example, an abbreviation might be "LA" and the full 
text "Los Angeles."  Any time you put "LA" on the city, first address line, or 
any of the comment lines it will be expanded to say "Los Angeles."

INDEXING (CONTROLLING THE SORTING SEQUENCE OF 
ENTRIES)

This menu lets you change the order in which the entries in your 
mailing list are displayed and printed.  There are four indexing options and 
two filter options from which to choose:

1. by Name ── will sort entries by Surname plus First Name plus a 
portion of the Company Name.

2. by Company Name ── will sort entries by Company Name plus 
Surname plus a portion of the First Name.

3. by Address ── will sort entries by the first address line plus a 
portion of Surname plus a portion of First Name plus a portion of Company 
Name.

4. by Zip/Postal code ── will sort entries by zip/postal code plus a 
portion of Address.

5. Filtered to include Selected records only.  This option, when 
activated (a dot appears to the left), allows only the records which are 
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selected for printing to be displayed and modified.  To state the reverse, any 
records which are not selected for printing will seem to be gone -- they will 
not show up on the screen nor on the F2 (Find) window.

6. Filtered to include Deleted records only.  When activated (a dot 
appears to the left), only records which are marked for deletion will show up 
on the Names data entry screen, including the F2 (Find) window.

Any potential conflicts of keys (as noted in earlier releases) have been
removed (if you don't know what I'm talking about, don't worry about it - it's 
fixed).

Changing the Index

The active index has a dot to the left of it.  To select a different index 
and/or to clear any filters (on the bottom section of the Index menu), just 
highlight or press the first letter of the index you would like to use.  Only one 
index can be active at a time.

Filters

A filter is a way of limiting what you see, just like a camera filter.  This
makes it easier to review certain entries, especially in very large mailing 
lists.

Setting a Filter

Let's say you selected all records in Group A for printing and then
wanted to browse that list, eliminating a few here and there to reach 
a goal of 75 mailings.  Just use the Index menu to set the "Selected 
filter" ON (a dot will appear to the left when it is ON).  You will see a 
bar graph as the open file is filtered (on smaller files it may fly by so 
quickly you'll barely know it was there).  Now, when you go to the 
Data Entry/Names screen you will see the first record on file which is 
selected for printing (which may not necessarily be the first actual 
record on file).

Pressing the PgUp and PgDn keys will move you around with the 
filtered list.  If you press the F2 (Find) key, the window will contain 
only the filtered list.  It may seem as if the other records are gone, but
a quick look at the status line at bottom of the screen will tell you that
the number of records in your file has not changed.
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Clearing a Filter

To clear a filter just select it again from the Index menu.  Filters 
are toggles — select once to turn ON, again to turn OFF, again to turn 
ON, etc. etc.

PREFERENCES

The Preferences menu contains options which help you customize the 
operation of WML and set necessary parameters, such as the type(s) of 
printer(s) you have.  Preferences are in two groupings on the menu, 
separated by a horizontal line.  The upper options are screens; the bottom 
two options are toggles (i.e., they are either "on" or "off").  A dot next to any 
of the bottom three toggles indicates that it is "on."

Please check each Preferences screen before making full use of WML, 
otherwise something might seem wrong with the software whereas it is due 
to the set of conditions under which WML is operating.

Setting Your Return Addresses

You can set up to two return addresses which you would like to print 
on laser envelopes.  Each address may contain up to four lines, and can 
include punctuation, even quotation marks and commas.

When you are finished with this screen you can click on "Ok" to save 
the information and exit, "Cancel" to ignore any changes and exit, or use the 
keyboard keys F7 to Save or Esc to cancel.

Choosing a Back-up Method

Under the File menu are options which allow you to back-up and 
restore your data to/from other disks for safety.  These operations will use 
the DOS COPY command unless you use this option to change it.

You will see a menu of four choices of methods to use when backing-
up and restoring:  DOS COPY (the default), ARJ, LHARC, or PKZIP.  In order to 
use ARJ, LHARC, or PKZIP compression software you must have the 
compression programme available in your DOS PATH.  In addition, you will 
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also need enough free memory (RAM) to run both WML and the compression 
software.

Mailing to Various Countries (Country setting)

WML has been designed to validate data differently for U.S., 
Canadian, and other (International) addresses.  By using the proper country 
setting you will have the following abilities and features:

♦ The U.S. setting will only allow numerical zip codes in the format 
#####-####, telephone numbers in the format (###) ###-
####, dates in the format MM/DD/YYYY, and state two-letter 
abbreviations.  If you enter a full State name (properly spelled, of 
course) WML will find its abbreviation for you.

♦ The Canadian setting allows postal codes only in the format A#A 
#A# (where A is a letter and # is a number), telephone numbers as
(###) ###-####, dates in the format DD-MM-YYYY, and province 
abbreviations.  If you enter a full province name WML will find its 
abbreviation for you.

♦ The U.S. & Canadian setting accepts data in either of the formats 
mentioned above.  Dates are presented in the format 
"## AAA ####".  For example, "17 Sep 1992".

♦ The International setting does the least "work" for you: it does not 
format zip codes or telephone numbers and does not look up 
state/province abbreviations.  Everything you enter is treated as 
literal information.  Dates are displayed in yyyy-mm-dd format.

Setting Envelope Size

I expect that most folks, like me, tend to use the same kind of 
envelope time and again, and it's probably a #10 "business" envelope.  So I 
decided to keep this screen simple and just have a single definition for an 
envelope which can be changed from time to time, if necessary.

There are just three numbers to fill in:  The width of the envelope (left
to right), the length (top to bottom), and the left margin for the return 
address.  Enter fractions of an inch as decimal figures (e.g., 1/2 is .5, 1/8 
is .125, etc.).  The left margin adjustment can be negative or positive.  A 
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negative number will move the return address to the left, a positive number 
will move it to the right.

Selecting Continuous (Dot Matrix) Label Types

Version 2 brings a vastly enhanced label system.  Now, instead of 
picking two labels from a list, you always have access to the entire list of 
defined label types.  And instead of only one user-defined label type, ALL 
label types are now user-definable.

WML is pre-configured for a few common label types, such as the 
ever-popular 1-across 3½-inch by 15/16-inch labels which are commonly sold
in boxes of 5,000.  There are several blank, undefined label types which you 
can set up yourself.  In addition, you can even change the pre-defined labels 
to whatever you need.

First you will see the menu of label choices.  Highlight the one you 
want to change and press ◂─┘Enter.  A window will open showing the name 
of the label and all of the measurements.  Type a short name (such as 
"Mailing", "Shipping", "Disk", etc.) to indicate the type of label.  Enter the 
width of the actual label (i.e., how much room there is upon which to print), 
the vertical distance from the top of one label to the top of the next, the 
horizontal distance from the left side of one label to the left side of the next, 
and the number of labels across.

You can use the Up and Down Arrow keys to move between lines, or 
point and click with a mouse.  When you are finished click on "Ok" to save or 
"Cancel" to abandon any changes, or use the keyboard keys F7 to Save or 
Esc to cancel.

Defining your Printers

Before you can print anything you will have to tell WML what type(s) 
of printer(s) you plan to use.  WML can use two printers, a laser and a dot 
matrix.  The laser can be used to print envelopes and laser labels.  The dot 
matrix can be used to print continuous labels.  Either printer can be used to 
print group lists and phone books.  Until you define your printer(s) and 
font(s) there will be a flashing message at the bottom of the screen and you 
will not be able to use the File/Print option.

The Printer definition window shows the current settings.  Use the 
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arrow keys to move around, and press the F3 key to change anything.  For 
example, to set your dot matrix printer move the cursor down to that line 
then press F3 and a menu of choices will appear.  Highlight your printer (or 
one compatible with it) and press ◂─┘Enter.  Then move down to the font 
definition and press F3 again.  Highlight your font selection and press 
◂─┘Enter.  When you are finished, highlight the "Ok" button and press 
◂─┘Enter.  Alternately, you can press F7 to save the screen and exit.

Laser Printer Soft Fonts

Version 2 of WML is much more flexible in handling laser printer 
soft fonts.  You can use any landscape PCL fonts (the file names will 
end with .SFL).  You decide which fonts to use once ── on the 
Preferences/Printers screen ── and, from then on, WML automatically 
uses those font choices.

Consider an example: When you set the font for the envelope 
return address you may choose any of your printer's built-in fonts or a
soft font.  If you select the first item in the font list, "Select a soft 
font," you will first be asked for the drive and/or path containing the 
files.  The last directory you used will be the default.

After you enter a correct path you will be shown a list of the 
landscape soft font files (*.SFL) in that directory.  Use the arrow keys 
and PgUp/PgDn keys to move around, highlight the one you want, and
press ◂─┘Enter.  The soft font file name, including the path, will now 
be shown on the Preferences/Printers screen.

Scalable Fonts

A new font "technology" is scalable fonts.  This is where a printer 
has a single font (e.g., CG Times, Helvetica, etc.) which can be printed
in any size.  I have only seen printers with built-in scalable fonts; I 
have yet to see how a scalable soft font works (I have no idea how 
one would work with WML) (try it and see) (then tell me!).

Printers like the H-P LaserJet III and IV and Okidata's dot matrix 
printer ML-391+ have scalable fonts built in.  This means you can pick
a font, such as Roman, and print in practically any size you want.

When you select a scalable font WML will prompt you for the 
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character pitch (cpi) or the point size, depending on whether it is a 
fixed-pitch or proportionally-spaced font.  Without going into too much
detail here, numbers between 8 and 14 work best.  I will write more 
on this in the detailed manual (available to registered users for $8; 
see Registration Form).  My favourite font for both my laser and dot 
matrix is a Helvetica-type (sans serif) font at 12cpi or 12 points.

Duplicate Checking

If you want to have WML check for duplicate personal names, 
company names, and/or addresses while you are entering information, just 
select any or all of these toggles.  A dot to the left of the toggle indicates 
that it is turned on.  You can toggle them on and off as desired.  The setting 
of these toggles will be saved when you exit WML.

Using duplicate checking is a good way to avoid duplicate entries 
which have different personal names attached to them or ones which have 
identical addresses but a different name.  The drawback to duplicate 
checking is that it may noticeably slow the computer down.  If you are 
working on a very large mailing list or a very slow computer you might want 
to try turning some or all of the duplicate checking options OFF to increase 
speed.

HELP

The Help menu has three options:  Index, About, and Settings.

Help/About gives you some information about your memory and how 
to reach me.

Help/Index gives you a list of help topics from which you may choose. 
This is like a brief on-line manual.  To use it just highlight a topic and press 
◂─┘Enter -- a helpful window of information will appear.

Help/Settings shows you the Preferences settings on a single screen 
so you can review them.

That's about all I can think to babble about.  Enjoy!
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